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1 - Installing the Software 
Product Components 

Your label design software is packaged with the following components: 

• CD ROM 

• Documentation appropriate to the version you purchased 

• A license agreement and registration card 

• Software security key 

System Requirements 

The basic software and hardware requirements needed to run the label design 

software are similar to those of most applications running on Microsoft 

Windows: 

• IBM-compatible PC, Pentium III or better. 

• Microsoft Windows 98, Windows Me, Windows NT 4.0, Windows 2000 

or Windows XP 

• Hard drive with at least 40 MB free disk space 

• CD ROM drive 

• 32 MB RAM with Windows 98 or Windows Me (64 MB recommended) 

• 64 MB RAM with Windows NT 4.0, Windows 2000 or Windows XP (128 

MB recommended) 

• VGA monitor or better 

• Hard drive with at least 40 MB free disk space 

• CD ROM drive 

Software Security Key 

The software includes a security key that must be installed on a PC to run the 

software. The security key is a small electronic device that contains information 

about the software version and the number of users that are authorized to run 

the label design software.  

 

The software security key is easy to use—simply connect it to the parallel port 

before launching the software. If a printer will be attached to the same parallel  
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port, connect the printer cable to the security key. The printer may need to be 

powered on before the key is recognized. 

Parallel port/DB25 female connector 

 

 

 

 

Figure 1  Connecting the software security key to your PC 

Note: Without the software security key, the program will run as a Demo version 

and will place a demo message on all labels printed with the software. 

Single User Installation 

1. Attach the software security key as directed in the "Software Security 

Key" section. 

2. Insert the CD. The CD's opening screen will appear. (If the CD does 

not automatically open, go to the Windows Start button / Run… 

dialog and type <Drive Letter>:\Disk 1\Setup.exe.) 

3. On the opening screen of the CD, select the product to install and then 

click the Run/Install button. 

4. Follow the instructions displayed on the screen to select and install the 

software. 

Network Installation 

Follow the guidelines below when installing a multi-user/network version of the 

label design software: 

• The label design software must be installed on a server along with the 

License Manager application. Any workstation that will run the label 

design software must also have the software installed locally. 

• The security key must be attached to the server. Only one security key 

is included with a network version of the software, pre-programmed 

with the number of licenses purchased. 

• The hard drive on the machine where the key is attached must be 

shared and mapped allowing full read/write access to all potential 

users. This is necessary for the network License Manager.  
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2 - About this Manual 
Introduction 

Congratulations on your purchase of this label design software. The wide range 

of features in the software allow you to create virtually any label and print to 

any of more than 850 printers. Text, one and two dimensional bar codes, 

graphics, shapes and other objects are easy to add through the intuitive user 

interface. 

This manual is designed to provide you with the basic information you need to 

install the software, set up a printer and design a label. More in-depth 

information on these topics and other more advanced topics can be found in the 

online Help. 

Typographical Conventions 

This guide uses the following conventions to distinguish between different types 

of information: 

• Terms taken from the interface itself, such as menu names, commands 

and button names appear in bold. 

• Keys appear in uppercase, as in the following example: 

"Press the SHIFT key." 

• Numbered lists indicate a procedure to follow. 

• The sequence for selecting a command from a menu will be described, 

but a button is also available for many functions. 

• Angle brackets < > indicate system setup information that must be 

entered by keyboard. Enter only the information, not the brackets. 

About Your Software 

Depending on the edition of the software you are using, different features are 

available. Although all features are described in this manual, they may not be 

available in your edition of the software. 
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Note: The License Manager application is not compatible with Novell systems, 

so Novell network users must designate a Windows workstation to be the key 

server. 

Network Installation Procedure 

1. Select one computer on the network to act as the key server. It can be 

the network file server, or any of the workstations. Install the label 

design software and the security key on this machine to load the 

necessary files. This machine must be running in order for the users to 

access the label design software. 

2. Run the LVLICENSEMANAGER.EXE application found in the program's 

root directory. This file is needed only on the machine that has the key 

attached. 

The License Manager application allows many users to access the label 

design software at the same time, from anywhere on the network. 

When users are logged onto the program, their user names will appear 

in the license manager window, so administrators can keep track of 

who is using the program. 

3. Install the software on each workstation where the label design 

software will be used. Through Windows, map the network drive where 

the label design software is installed. Refer to your Windows manual or 

system administrator for the necessary instructions. 

4. For each installation, run the label design software, select 

Configuration… from the Options menu and click on the Network 

tab. Check the Network Key box, and use the  button or Auto 

Find… button to specify the location of the SYSTEM\LICENSE 

directory, found on the mapped drive established in step 3. 

5. Shut down and restart the label design software to complete the 

network installation. 

Viewing the Readme File 

The Readme.txt file delivered and installed with the software contains 

information about the most recent changes and updates to the label design 

software that were made after this manual was printed. This information 

supercedes what is contained in this manual. 
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Technical Support 

For telephone technical support contact your label design software supplier. 

Online support is available free of charge at www.autobag.com under SUPPORT. 

 
Help 

Contact: 

Automated Packaging Systems, Inc. 

Customer Service Department 

1-800-527-0733 

Service Support Department 

1-888-277-0785 
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3 –tting Started 

3 - Getting Started 
 
Introduction 

This chapter is designed to familiarize you with the main features of the user 

interface, help you configure the interface to meet your needs, and set up a 

printer in preparation for printing labels. 

 

Starting the Program 

1. On the Windows taskbar click the Start button and then point to 

Programs. 

2. Locate the label design software group in the list of available programs 

and point to it using your mouse. 

3. Click on the label design software listing to launch it. 

 

Exploring the Main Window 

This section presents a general overview of the main interface elements as they 

appear in the main window at the beginning of a work session. 

Menu Bar 

The Menu Bar is composed of eight command menus: File, Edit, Draw, View, 

Tools, Options, Server and Help.  

� To open a menu: 

1. Click on the menu with the left mouse button. 

2. Choose the required command. 
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Style Bar 

The Style Bar contains a variety of tool buttons that are used to open and save 

labels, print labels and control other label design display and setup properties. 

Many of the Style Bar functions are also available from the File menu. 

 

Button Tool Name Purpose 

 
New Creates a new, blank label. 

 
Open Opens an existing label. 

 
Save Saves changes made to the 

current label. 

 
Print Prints the current label. 

 
Snap to Grid Displays the label design grid 

that forces objects to line up 
according to the grid 
settings. 

 
Zoom In Zooms in on the currently 

active label design, allowing 
you to view images on an 
enlarged scale. 

 
Zoom Out Zooms out of the currently 

active label design, allowing 
a larger portion of the label 
to be viewed on the design 
screen. 

 
Name Mode Displays the fields using their 

field names. 

 
XXX Mode Displays the fields as a series 

of "X" characters. 

 
Value Mode Displays a sample value for 

the field. 

 
Help Displays the online Help. 
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Server Bar 

The Server Bar contains tool buttons that activate several advanced data 

integration features available in this label design software. 

 

Button Tool Name Purpose 

 
DataWatch Server Activates the DataWatch 

feature. 

 
DDE Server Activates the DDE Server 

feature. 

 
Command File Activates the Command File 

feature. 

 
LabelSelect Activates the LabelSelect 

feature. 

 

Drawtools Bar 

The Drawtools Bar allows you to add text, bar codes, pictures and other objects 

to your label design. The Drawtools Bar functions are also available from the 

Draw menu. 

 

Button Tool Name Purpose 

 

Add Text Adds a text field to the 
current label. 

 

Add Paragraph Adds a paragraph to the 
current label. 

 

Add Bar Code Adds a bar code to the 
current label. 

 

Add 2D Bar Code Adds a 2D bar code to the 
current label. 

 

Add Picture Adds a picture to the current 
label. 

 

Add OLE Object Allows you to embed an 
object created in another 
application. 
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Add Box Adds a box or rectangle to 
the current label. 

 

Add Line Adds a line to the current 
label. 

 

Add Shape Adds a shape to the current 
label. 

 

Float Bar 

The Float Bar tool buttons are used to position objects on the label in relation to each other. 

 

Button Tool Name Purpose 

 
Align Left Aligns selected objects with 

the left edge of the left-most 
object selected. 

 
Align Right Aligns selected objects with 

the right edge of the right-
most object selected. 

 
Align Top Aligns selected objects with 

the top edge of the top-most 
object selected. 

 
Align Bottom Aligns selected objects with 

the bottom edge of the 
bottom-most object selected. 

 
Center Vertically Centers selected objects 

vertically. 

 
Center Horizontally Centers selected objects 

horizontally. 

 
Equal Space Vertically Spaces selected objects 

vertically. 

 
Equal Space Horizontally Spaces selected objects 

horizontally. 
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Status Bar 

The Status Bar is located at the bottom of the design screen. The left side of 

the Status Bar serves as a message area that gives instructions and information 

as to what you are expected to do next. Other information status indicators 

displayed from left to right include the name of the selected printer, the 

communication port to which it is connected, and the coordinates of the current 

cursor position. 

 

 

Figure 2  The Status Bar 

Rulers 

The label design software displays two rulers (left and top of design area) that 

can be used by the operator to judge the positioning of the fields to be placed 

on the label. The rulers are displayed in the currently selected units (inches or 

millimeters).  

Rotation Button 

The Rotation button  is located in the top-left corner of the design area, 

where the two rulers meet. When designing a label that prints sideways, the 

Rotation button allows you to rotate the view of the label so you can more 

easily design the label in a normal view. You can rotate the view 0, 90, 180, or 

270 degrees relative to the print orientation. This affects only the display of the 

label, not printing. 

Design Area Display Settings 

The display settings enable you to change program settings to customize your 

label design environment. Settings included on this tab include language 

selection, units of measure, display of the grid, ruler colors, etc. 

� To change the display settings: 

1. Select Configuration… from the Options menu and then click on the 

Display tab. 

2. Configure the display settings as appropriate for your label design 

application. 
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Printer Setup 

This program supports hundreds of specialized thermal and thermal transfer 

label printers and any printer with a valid Windows driver supplied by the 

manufacturer. Printer drivers included with this label design software are 

installed to the program's Drivers directory when the program is installed.  

� To install a thermal or thermal transfer label printer: 

1. In the label design software, select Select Printer… from the File 

menu and then click the Install button. 

2. Select the printer to be installed from the Available Printer Drivers list 

and click the Install button. The new printer will be copied to the 

Installed Printers list. 

3. Click Connect and choose the correct port. 

4. If the printer is connected to a serial port, the driver (in the Windows 

Printer folder) will need to be configured to match the printer settings 

(baud rate, data bits, stop bits, parity, flow control). Refer to the 

printer's documentation to determine these settings. 

5. Click OK/Close until the main screen reappears. 

 

� To select a printer: 

1. In the label design software, select Select Printer… from the File 

menu. 

2. Click on the Printer drop-down list to display a list of installed printers. 

3. Select the appropriate printer and click OK. 
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4  Designing Labels 

4 - Designing Labels 
 

Introduction 

This chapter introduces some of the most frequently used features and 

functions of the label design software to get you off to a quick start on creating 

labels. 

Creating a New Label 

1. Select New from the File menu. The Label Setup tabs will appear. 

2. Fill in the settings on the Label Setup tabs as appropriate and click OK 

when finished. 

Opening a Label 

1. Select Open from the File menu. 

2. Locate the desired label file and double-click on it to open it in the 

label design software. 

Note: If the label was originally created for a printer other than the one 

currently selected, you will be asked if you want to convert the label to the new 

printer. If "No" is chosen, the label will not open. 

Moving an Object on the Label 

1. Place the mouse cursor over the selected object. 

2. Click the left mouse button and drag to move the object to the desired 

location. 

Sizing an Object on the Label 

1. To size the object while keeping the aspect ratio of the height and 

width the same, click on one of the four corners of the object handles 

(so the cursor is at a diagonal). 

2. Drag to the desired size. 
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Printing a Label 

1. Click the Print button or select Print from the File menu. 

2. For labels getting their values from a database, click the  button to 

view and choose the database record(s) to be printed. 

3. Click the Print button to send the label design to the selected printer. 

 
Adding Objects to the Label 

Adding Text 

1. Click the Add Text button  to display the Text properties tabs. 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 3  Text Properties Tabs 

2. Set the following settings as appropriate for the text object: 

Font: Allows you to select the desired typeface to use for the text 

object. 

Point Size: Controls the height and width of the font. 
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Style: Select from the list of available styles (bold, italic, underline) for 

the selected font. 

Rotation: Controls the orientation of the text object. The options are 

Normal, Sideways Up, Sideways Down, and Upside Down. 

Data Source: Determines the source from which the text object will 

get its value. The default data source is Fixed (never changing). See 

the "Data Sources" chapter for more information. 

Text String: Allows you to type the text to be printed on the label. 

3. Click OK and then click on the label in the position where you want to 

place the text. 

Adding a Paragraph 

1. Click the Add Paragraph  button to display the Paragraph 

properties tabs. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 4  Paragraph Properties Tabs 
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2. Set the following settings as appropriate for the paragraph object: 

Characters/Line: Number of characters to appear on each line of the 

paragraph.   

Maximum Lines: Determines the number of lines used for the 

paragraph object. If the paragraph text file contains more information 

that can appear within this maximum line setting, then some of the 

data will not appear. 

Line Spacing: Amount of space between each line of text. This value 

must be specified as a number of dots (the smallest unit of 

measurement on the printer). 

Word Wrap: If Word Wrap is set to Yes, if the word at the end of the 

line would extend beyond the specified number of characters, the word 

will be moved to the next line.  If Word Wrap is set to No, the last 

word on the line will be truncated if it extends too far, and the rest of 

the file will be lost.  

Justification: Aligns the text (according to the rotation of the 

paragraph) to the left or right margins, or centers the lines within the 

space allowed. 

Data Source: Determines the source from which the paragraph object 

will get its value. The default data source is Fixed (never changing). 

See the "Data Sources" chapter for more information. 

Paragraph File: This setting appears only if the source of data is 

Fixed. The name of the text (.TXT) file containing the actual paragraph 

text should be entered here. 

 

3. Click OK and then click on the label in the position where you want to 

place the paragraph. 

Adding a Bar Code 

1. Click the Add Bar Code button  to display the Bar Code properties 

tabs. 
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Figure 5  Bar Code Properties Tabs 

2. Set the following settings as appropriate for the bar code object: 

Bar Code Type: Select one of over 30 different bar code symbologies 

supported by the label design software. 

Rotation: Controls the orientation of the bar code object. The options 

are Normal, Sideways Up, Sideways Down, and Upside Down. 

Multiplier: While the relative thickness of the bars is defined by the 

bar-width ratio, the overall thickness of the bars can be changed using 

the bar width multiplier. Use this value to adjust the overall width of 

the bar code. 

Bar-Width Ratio: Controls the relative size between thick and thin 

bars and spaces. 

Height: Specifies the height of the bar code in inches or millimeters, 

depending on the configuration setup. 

Bar Code Value: This setting appears only if the source of data is 

Fixed. The actual value for the bar code should be entered here.  

3. If you want human readable text to be printed along with the bar 

code, click on the Human Readable tab and select Yes from the drop-

down list.  
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4. Click OK and then click on the label in the position where you want to 

place the bar code. 

Adding a 2D Bar Code 

1. Click the Add 2D Bar Code  button to display the 2D Symbology 

properties tabs. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 6  2D Symbology Properties Tabs 

 

2. The settings that appear on the 2D Symbology tab vary depending on 

the 2D bar code type selected. Fill in the settings as appropriate for 

your 2D bar code object. 

3. Click OK and then click on the label in the position where you want to 

place the 2D bar code. 
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Adding a Picture 

1. Click the Add Picture button  to display the Pictures properties 

tabs. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 8  Picture Properties Tabs 

 

2. Set the following settings as appropriate for the picture object: 

Rotation: Controls the orientation of the picture object. The options 

are Normal, Sideways Up, Sideways Down, and Upside Down. 

Ratio: Determines if and how the image can be resized. Fixed means 

both the height and width will remain proportional as the size changes. 

Stretchable means there is independent control of the height and the 

width. Non-Resizable means the picture cannot be resized. 

Data Source: Determines the source from which the picture object will 

get its value. The default data source is Fixed (never changing). See 

the "Data Sources" chapter for more information. 

Pictures: This setting appears only if the source of data is set to 
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Fixed. The name of the picture file (i.e. logo.pcx) should be entered 

here. 

3. Click OK and then click on the label in the position where you want to 
place the picture. 

Adding an OLE Object 

1. Click the Add OLE Object button  to display the Insert Object 

dialog. 

 

 

 

 

 

 

 

 

 

Figure 7  Insert Object Dialog 

 

2. Select one of the following options: 

Create New: The Object Type list displays objects from your other 

installed applications that support OLE (Object Linking and 

Embedding). Select an object type from the scroll list and click OK. 

The selected program will open, allowing you to create a new object 

using that program. 

Create from File: If the object you require is already saved on your 

system, use this option to locate it. You will be prompted to type in the 

location and name of the file, or you can browse your system to find it.  

3. Click OK and then click on the label in the position where you want to 

place the object. 
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Adding a Box 

1. Click the Add Box button  to display the Box settings. 

2. Set the following settings as appropriate for the box object: 

Horizontal/Vertical Thickness: Sets the horizontal (top/bottom) and 

vertical (sides) thickness of the lines for the box. 

Color: Set the color for the box object. 

3. Click OK and then click on the label in the position where you want to 

place the box. 

Adding a Line 

1. Click the Add Line button . 

2. Click on the label in the position where you want the line's start point 

to be and then drag using the mouse to create the line. 

3. If you want to change the width, height or color of the line, double-

click on the line object to display the Edit Line dialog. 

4. Edit the line settings as desired. 

Adding a Shape 

1. Click the Add Shape button  to display the Shapes properties 

tabs. 
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Figure 9  Shapes Properties Tabs 

2. On the Shapes tab in the Shape Category box, click the category that 

contains the shape you want. For example, if you are looking for a 

hammer, click Tools. All the available shapes for the selected category 

appear. 

3. Scroll through the displayed shapes and click the shape you want. It 

will appear in the lower portion of the dialog box. 

4. Set the following settings as appropriate for the shape object: 

Rotation: Controls the orientation of the text object. The options are 

Normal, Sideways Up, Sideways Down, and Upside Down. 

Ratio: Determines if and how the image can be resized. Fixed means 

both the height and width will remain proportional as the size changes. 

Stretchable means there is independent control of the height and the 

width. Non-Resizable means the picture cannot be resized. 

Click OK and then click on the label in the position where you want to place the 

shape.
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5 – Data Sources 

 
Introduction 

This label design software allows you to use fixed or variable data sources for 

text and bar code objects/fields. The selected data source will determine the 

origin from which the object will get its value. An object with a fixed data 

source is defined when you create the object. An object with a variable data 

source does not have its value defined at the time of creation, but instead 

receives its value from the data source at the time of printing. 

This chapter provides an overview of the types of data sources that are 

available with the software. Only a brief overview appears here; additional 

information can be found in the online Help. 

Note: Not all data sources are available for all object types. 

Fixed 

The Fixed data source requires you to enter the data when the object is 

created, and this data never changes. Fixed is the default data source. 

When Printed 

The When Printed data source prompts the operator to type in the data at print 

time. 

Linked 

The Linked data source allows you to take information from one or more other 

fields on the label, or perform mathematical calculations. All fields are referred 

to by their FIELD NAME. 

dBase 

With the dBase data source, the data is retrieved from a dBase III or IV 

compatible database. The operator will be asked to enter the key field data at 

print time (i.e. "Enter Part Number:") which is then used to retrieve other 
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related information from the database, such as price/unit, color, etc.  

 

ODBC DB 

With the ODBC DB data source, the data is retrieved from an ODBC database 

that must first be set up through the Windows Control Panel. Once the ODBC 

driver has been set up, you must select the driver to use by selecting 

Directories… from the Options menu and then clicking the Data Source… 

button. When printing, the user is prompted for a key value, such as part 

number, which is then looked up in the database to retrieve related 

information, such as price/unit. 

OLE DB 

The OLE DB data source is similar to the ODBC DB data source in that it allows 

data from many different formats to be added to labels. However, OLE DB 

technology is newer, is more stable, and is easier to set up than ODBC. Select 

Configuration… from the Options menu and then click on the OLE DB 

Manager tab to set up the links before adding the field to the label.  

Date / Time Stamp 

With the Date or Time data source, the current date or time is retrieved from 

the computer when the label is printed. Several date and time formats are 

available. All labels in a single batch will have the same time printed on them.  

Serial File 

With the Serial File data source, a serial number is retrieved from a serial file at 

the time of printing. This file is updated after printing so that the information 

can be used again without operator intervention. The label will begin counting 

again from the point where it finished.  

CommWatch 

The CommWatch data source retrieves the data from an external device 

through the computer's serial port. This allows information to be included from 

weigh scales, scanners, sensors, or PLCs. 

Accumulator File 

The Accumulator File data source can take data from any field on a label after 
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printing and add its value to a pre-determined file. This accumulator file can 

take data from multiple label formats. The accumulated data can then be 

printed to any label as a data source.  

Pick List 

With the Pick List data source the data comes from a pre-configured drop-down 

list, allowing exact entry of data with no user errors or unauthorized entries.  

Shift Code 

A Shift Code data source allows the printed data to change depending on what 

time of day the labels are printed. This type of data source is used to keep 

track of the work shift (day shift, night shift, etc.) that printed certain labels by 

setting up the label to automatically include the shift information on each label. 

Data Dictionary 

The Data Dictionary data source calls a predefined series of When Printed fields 

to be used with DDE exchanges and automated printing routines.  




